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Creating Climographs
Adapted from: My NASA Data Lesson Plans
http://mynasadata.larc.nasa.gov/preview lesson.php?&passid=74

Focus on Inquiry

The student will focus on inquiry by using the Internet to collect real satellite temperature and precipitation
data of several islands in the Pacific. The student will create climographs using Excel for each location,
make predictions, compare and contrast the data, look for patterns, and provide explanations for the
findings.

Lesson Overview

The students will use NASA satellite data to compare surface temperature and precipitation of different
islands in the Pacific Ocean.

Duration Setting Grouping PTI Inquiry Subskills
2-3 50 minute class periods | Classroom/computer lab | Small groups of 2-3 3.1,3.6,3.8,4.2,4.3,4.4,
52,53,54,7.2,7.3
Estimated Inquiry Technolo Level of
Lesson Components ) Subskills 9y Student Brief Description
Time Used
Used Engagement
Students interact in a class
10 Computer/ d!scussmn apout climate and
Engage . 5.2 2 discuss possible reasons for
minutes Internet . R
differences in climate between
2 locations.
Students gather temperature
31 3.6 Computer/ and precipitation data for
2 class S Internet; several islands in the Pacific,
Explore . 3.8,4.2, . 3 -
periods a4 Microsoft create a climograph for each
’ Excel island using Excel, and
manipulate the data.
Students analyze their resulting
4.2,4.3, climographs for each island,
Explain 20 5.2,5.3, 3 compare and contrast the data,
P minutes 5.4,7.2, make predictions, and propose
7.3 reasons for the similarities and
differences in the data.
31,36, Students complete the activity
3.8,4.2, Computer/ . A
1 class 43 44 Internet: yvorksheet usmg.another island
Expand - . 3 in a different region, create a
period 5.2,5.3, Microsoft i h and h
54 72 Excel climograph, and compare the
73 ’ data to the first three islands.
Student answers to questions
Evaluate and the climographs created
can be used as assessment.
Level of Student Engagement
1 Low Listen to lecture, observe the teacher, individual reading, teacher demonstration, teacher-centered instruction
2 Moderate Raise questions, lecture with discussion, record data, make predictions, technology interaction with assistance
High Hands-on activity or inquiry; critique others, draw conclusions, make connections, problem-solve, student-
centered

National Science Education Standards — Inquiry

Use appropriate tools and techniques to gather, analyze and interpret data

Develop descriptions, explanations, predictions, and models using evidence

Think critically and logically to make the relationships between evidence and explanations

Communicate scientific procedures and explanations

National Science Education Standards — Earth Science

Global patterns of atmospheric movement influence local weather. Oceans have a major effect of climate,
because water in the oceans holds a large amount of heat.

Louisiana Grade Level Expectations — Inquiry k

Gr. 8, Inquiry GLE#6 - Select and use appropriate equipment, technology, tools, and metric system units of
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measurement to make observations (SI-M-A3)
Gr. 8, Inquiry GLE#9 — Use computers and/or calculators to analyze and interpret quantitative data (SI-M-A3)
Gr. 8, Inquiry GLE#11 — Construct, use, and interpret appropriate graphical representations to collect, record, and report
data (e.g., tables, charts, circle graphs, bar and line graphs, diagrams, scatter plots, symbols) (SI-M-A4)
Gr. 8, Inquiry GLE#12 — Use data and information gathered to develop an explanation of experimental results (SI-M-A4)
Gr. 8, Inquiry GLE#13 — Identify patterns in data to explain natural events (SI-M-A4)
Gr. 8, Inquiry GLE#16 — Use evidence to make inferences and predict trends (SI-M-A5)
Gr. 8, Inquiry GLE#19 - Communicate ideas in a variety of ways (e.g., symbols, illustrations, graphs, charts,
spreadsheets, concept maps, oral and written reports, equations) (SI-M-A7)
Gr. 8, Inquiry GLE#22 - Use evidence and observations to explain and communicate the results of investigations (SI-M-
A7)
Louisiana Grade Level Expectations Earth Science
Gr. 8, GLE#25 - Explain and give examples of how climatic conditions on Earth are affected by the proximity of water
(ESS-M-A11)
Gr. 8, GLE#26 — Describe and illustrate the layers of Earth’s atmosphere (ESS-M-A11).
Gr. 8, GLE#27- Identify different air masses, jet streams, global wind patterns, and other atmospheric phenomena and
describe how they relate to weather events, such as El Nifio and La Nifia

Materials List (per group)
e  Computer with Internet and Printer Access
Spreadsheet software (such as Excel)
Copy of a World Map: http://www.eduplace.com/ss/maps/pdf/world_country.pdf
Optional: Microsoft Word or Publisher to create travel brochures

Advance Preparation

1. Gather materials necessary to complete lab (have students bring in the necessary supplies)

2. Check to see that the browser being used is compatible with the Live Access Server (LAS)
http://mynasadata.larc.nasa.gov/las15/servlets/dataset and have this website already open on each
group’s computer before the activity begins.

3. Make sure the pop-up blocker is turned off on the computer’s browser.

4. Optional: If possible, you could have the students could print the graphs obtained in Parts 1 and 2
from the worksheet instead of saving the information to the desktop. If this is possible, make sure
the computers are connected to the printer and able to print.

5. Make sure you have copies of world maps to hand out to each group.

Other Information
Learning Objectives

e Make inferences about an area’s climate based on interpreting data on a climograph
Make inferences about an area's climate based on interpreting data on a weather graph
Create graphs using Microsoft Excel
Explain the difference between weather and climate

Prior Knowledge Needed by the Students
e Accessing Internet
e Familiarity with spreadsheet software (Microsoft Excel)

Procedure

Engage
1. Assess prior knowledge of students about climate. Use the following links to show pictures of two
different climates. If possible, locate these two locations on a map.
Guam: http://www.japanamac.com/pictures/guam?2.jpg
San Francisco http://johnstodderinexile.files.wordpress.com/2006/12/at-lands-end-san-francisco-
dec-28-2006.jpg
2. Ask the students possible reasons for differences in climate between these two locations. Accept
all answers.

Explore
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1. Make sure all computers are connected to the Live Access Server (Armstrong).
http://mynasadata.larc.nasa.gov/las15/servlets/dataset.

2. Have the students follow the directions on the Blackline Master 1 provided. Be sure pop-up
windows are allowed on the computer’s browser or else students will run into issues with viewing
their results.

3. Atthe end of the activity, the students will have to plot the locations on a world map. Make sure
each student has a copy of a World Map to do this. You can find them online at
http://www.eduplace.com/ss/maps/world.html. This one is a good one to use:
http://www.eduplace.com/ss/maps/pdf/world_country.pdf.

Explain
1. Have students answer the questions on the Blackline Master 1 provided.

Expand
1. Students can research Climate Data (Temperature and Precipitation) for another island of their

choice in a different region of the world and create a climograph for that island by following the
steps on the Blackline Master 1.

2. Using the data obtained, students can make predictions about the type of climate region found at
the island and compare and contrast the data with the other three islands.

3. Optional: Students can create a travel brochure using Microsoft Publisher or Word for each island
location.

Evaluate
1. Students can be assessed by using the answers to the questions on the Blackline Master 1 and the
student-generated projects (climographs).

Blackline Master
1. Creating Climographs

Supplementary Resources

See website for additional information

Credits
My NASA Data Lesson Plans
Aileen Ortega Canos, Yigo, Guam
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Creating Climographs
Procedure:
Part 1: Obtaining Temperature Data

1. You should be connected to the NASA Live Access Server:
http://mynasadata.larc.nasa.gov/las15/serviets/dataset

2. From this website, click on Land.

3. Click on the box beside Monthly Surface Clear-sky Temperature (ISCCP). Click Next.

4. For Select view, select Time series (t).

5. For Select output, select Table of Values (text).

6. In the latitude and longitude boxes to the right of the map, enter 13 N and 144 E. Click the Go
button underneath these boxes.

7. Underneath the map, select the time range to be Jan-2004 to Dec-2004. Click Next.

8. A text table of the Average Clear Sky Temperature should appear. Save this data for later. Select

File > Save As - Choose the Desktop or another location to save this file - Enter the File Name
as Average Clear Sky Temperature - Click Save. If possible, you could instead just print this
data table.

Part 2: Obtaining Precipitation Data

1. Go back to the home page: http://mynasadata.larc.nasa.gov/las15/serviets/dataset

2. This time, click on Water.

3. Click on the box beside Monthly Precipitation (CMAP). Click Next.

4. For Select view, select Time series (t).

5. For Select output, select Table of Values (text).

6. In the latitude and longitude boxes to the right of the map, enter 13 N and 144 E. Click the Go
button underneath these boxes.

7. Underneath the map, select the time range to be Jan-2004 to Dec-2004. Click Next.

8. Atext table of the Average Monthly Precipitation should appear. Save this data for later. Select

File > Save As - Choose the Desktop or another location to save this file > Enter the File Name
as Average Monthly Precipitation - Click Save. If possible, you could instead just print this data
table.

Part 3A: Inputting Data into Excel
1. Using the data tables you had obtained for the Average Clear Sky Temperature and the Average
Monthly Precipitation, input this data into Microsoft Excel.

2. Open Microsoft Excel and create a new spreadsheet.

3. In Column 1A, label it ‘'Months'. Under this column, in rows 2-13, label each number with the names
of the months of the year listed in chronological order (i.e., Jan, Feb, Mar, etc.).

4. In Column 1B, label it 'Precipitation (day)'.

5. In Column 1C, label it 'Precipitation (month)'.

6. In Column 1D, label it " Temperature (K)'.

7. In Column 1E, label it 'Temperature (C)".

8. Using the data you collected in Parts 1 and 2, fill in your Temperature data (Column B) and

Precipitation data (Column D) under the appropriate column headings. Do not input any data into
Column C and E. You should be able to find the data files on your desktop or wherever you saved
them, or you can copy the data from your print-outs if you used that option.

9. Save this Excel spreadsheet to your desktop or another location with the file name as Climograph.

Part 3B: Changing Kelvin into Celsius
1. Once all your data is inputted into your table, you will create a formula that will convert the
Temperature from degrees Kelvin into degrees Celsius.
2. In Column E Row 2, type in this formula' = D2 - 273.15 .
3. Next, copy and drag the formula into the remaining cells below Column E Row 2 (in Column E
Rows 3 to 13.)
4. The new information you should have will reflect the new temperature stated in degrees Celsius.

Part 3C: Changing mm-day into mm-month
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1. Once all your data is inputted into your table, you will create a formula that will convert the
Precipitation Measurements from millimeters per day into millimeters per month.

2. In Column C Row 2, type in this formula'=B2 * 30 ".

3. Next, copy and drag the formula into the remaining cells below Column C Row 2 (ex. Column C
Row 3 to 13.) Note: If you want to be really exact, you can instead enter individual formulas for
each month, using the actual numbers of days in the month. Remember that 2004 was a leap year.

4. The new information you should have will reflect the total amount of rainfall in one month.

Part 4A: Creating a Climograph
Note: These directions may vary based on the version of Excel you have.

1. On your Excel spreadsheet, highlight Columns A, Column C and Column E. (Note: You can
highlight multiple columns by pressing the Ctrl key while you click each column.)

2. Using the Chart Wizard on Excel, click on the tab labeled Custom Types. Select, Line-Column.
Click Next. (Note: If you can’t find this option, or you are not using the Chart Wizard, go to the
Insert menu, and select the “Line” option in the Charts area. Also, the following steps 3-5 may not
apply, and instead you may have to manually add the labels by using the options on the Layout
menu.)

3. On Step 2 of 4, click Next.

4. On Step 3 of 4, under the tab labeled Title. Input the following information:

a. Chart Title - Climograph for Guam

b. Category (X) Axis - Data 2004

c. Value (Y) Axis - Average Precipitation (mm)

d. Second Value (Y) Axis - Average Temperature (C)

5. On Step 3 of 4, under the tab labeled Axes, look for Secondary Axis and check mark the box in
front of Value (Y) Axis. (Note: If you are not using the Chart Wizard, you may have to instead
follow these directions to add a secondary axis. In the chart, click the data series that you want to
plot on a secondary vertical axis. On the Format tab, in the Current Selection group, click Format
Selection. On the Series Options tab, under Plot Series On, click Secondary Axis and then click
Close.)

6. Click Finish. Your climograph will be placed on the spreadsheet you just created.

Part 4B: Fixing Scales on Temperature Axis
Note: These directions may vary based on the version of Excel you have.

1. Click on the climograph you just created. On the climograph, double click on the right x-axis where
the temperature scale is located. A pop-up box will appear. (If a pop-up box does not appear, right
click while the temperature scale is highlighted and select the Format Axis option.

2. In the pop-up box, click on the tab labeled Scale. Remove the check marks that are located under
Auto. (Note: You may instead see an “Axis Options” section. Change the selections from Auto to
Fixed and then input the values in steps 3-7.)

Change Minimum to -5.

Change Maximum to 35.

Change Major Unit to 5.

Change Minor Unit to 1.

Change Category X Axes Crosses at to -5.
Click Ok.

©NOo O AW

Part 5: Obtaining Climate Data for other Pacific Islands

1. Repeat Parts 1 to 4 for the following island locations found in the Pacific Ocean - Fiji and Aleutian
Islands. Here are the latitude and longitude data for each location:
Fiji: Latitude: 18 S Longitude: 175 E
Aleutian Islands: Latitude: 54 N Longitude: 164 W

2. In Step 6 of Part 1 and Part 2, be sure to change the latitude and longitude accordingly.

3.  When inputting your data into Excel, be sure to create new spreadsheets for each island. Also,
remember to change the island names to reflect the data that you collected.

Part 6: Plotting Coordinates
1. On aworld map, plot the coordinates for each island location.
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1. How do you think location (latitude and longitude) affects the weather on each Pacific island?

2. How do temperature and precipitation differ in Guam and Fiji? How are they similar?

3. Why is the weather at the Aleutian Islands different from the weather found at Guam and Fiji?

4. What kind of climate region (tropical, dry, moderate, continental, polar) can you expect to see if you visit

Guam? Fiji? the Aleutian Islands?

5. How is the graph you created similar to a real climograph?

6. How does this graph differ from a real climograph?
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